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Cisco UCS Director Express for Big Data
Cisco UCSDirector Express for Big Data is a single-touch solution within Cisco UCSDirector that automates
deployment of Big Data infrastructure. Cisco UCSDirector Express for Big Data provides a single management
pane across physical infrastructure and across Hadoop and Splunk Enterprise software. It supports key Hadoop
distributions, including Cloudera, MapR, and Hortonworks.

Cisco UCS Director Express for Big Data delivers end-to-end automation of Hadoop cluster deployment,
allowing you to spin up and expand clusters on-demand. The physical infrastructure configuration is handled
automatically, with minimal user input. The configuration includes compute, internal storage, network, and
installation of operating system, Java packages, and Hadoop, along with the provisioning of Hadoop services.
This is achieved through Cisco UCS service profiles wherein both the physical infrastructure and Hadoop
configuration are incorporated into a Hadoop cluster deployment profile.

Cisco UCS Director Express for Big Data also delivers end-to-end automation of Splunk cluster deployment,
with minimal user input. This is achieved through Cisco UCS service profiles wherein both the physical
infrastructure and Splunk configuration are incorporated into a Splunk cluster deployment profile.

Cisco UCS Integrated Infrastructure for Big Data
Cisco UCS Integrated Infrastructure for Big Data is an industry leading architecture designed to meet various
Big Data workloads. It scales as processing and storage needs growwithout increasingmanagement challenges
and delivers predictable performance along with reduced total cost of ownership (TCO).

Cisco UCS Integrated Infrastructure consists of the following components:

• Cisco UCS Fabric Interconnects

• Cisco UCS Fabric Extenders

• Cisco UCS C-Series Rack-Mount Servers

• Cisco UCS S-Series Storage Servers

• Cisco UCS Virtual Interface Cards (VICs)

• Cisco UCS Manager

You can read more about the Cisco UCS Integrated Infrastructure for Big Data in the Data Center Designs
Cloud Computing - Design Zone for Big Data .

Managing Cisco UCS Director and Cisco UCS Director Express
for Big Data Personalities

Cisco UCS Director is the default personality made available after deployment, but you can choose to use
only Cisco UCS Director Express for Big Data, or use both Cisco UCS Director and Cisco UCS Director
Express for Big Data.

You can manage personalities here: Administration > License > License Keys > Manage Personalities.
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You must first configure the optimized multi-node setup and then select Cisco UCS Director Express for
Big Data or Cisco UCS Director and Cisco UCS Director Express for Big Data personality. We also
recommend that you do not change the personality in the appliance that is already in use. For more information
on how ro configure the multi-node, see Cisco UCSDirectorMulti-Node Installation and Configuration Guide.

Important

Table 1: Personality Switch Behavior

Cisco UCS Director Express for Big Data
Features

Cisco UCS Director FeaturesPersonality Selection

NoYesCisco UCSDirector (Default)

YesNoCisco UCS Director Express
for Big Data

YesYesCiscoUCSDirector and Cisco
UCSDirector Express for Big
Data

Depending on the personality, you start with and the personality selection, Cisco UCS Director and Cisco
UCSDirector Express for Big Data features are enabled or disabled with the restart of services on the appliance.

Note

Creating User Roles
You can create user roles that are specific to Cisco UCS Director Express for Big Data, and define menu
settings and permissions for those users. Ensure that you create a group before you add users to any role.

You can determine the default roles only if the Default Role column on the User Roles page is marked with
Yes in the system. Navigate to Administration > System > User Roles.

Note

For example, you can create the following user roles, and then create users with those role:

• HadoopUser—A Hadoop user

• HadoopAdmin—A Hadoop administrator

For more information on Managing Users and Groups, see the latest Cisco UCS Director Administration
Guide.

Hadoop Administrator Permissions
A Hadoop administrator can:

• Read—Permission to only read a file.

• Write—Permission to read, write, and modify a file.
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• Read/Write—Permission to read and/or write to a file

The following table shows a list of operations that a Hadoop administrator can do:

PermissionsOperations

WriteRead

Yes (Only VM Management
Actions)

YesVirtual Computing

—YesVM Label

—YesAssign VM to VDC

YesYesVirtual Storage

YesYesVirtual Network

YesYesPhysical Computing

YesYesPhysical Storage

YesYesPhysical Network

YesYesGroup Service Request

YesYesApprover Service Request

YesYesBudgeting

—YesResource Accounting

—YesChargeback

YesYesSystem Admin

YesYesUsers and Groups

YesYesVirtual Accounts

YesYesCatalogs

YesYesVDC

YesYesComputing Policy

YesYesStorage Policy

YesYesNetwork Policy

YesYesService Delivery

YesYesResource Limit Report

YesYesGroup Users
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PermissionsOperations

WriteRead

YesYesCloudsense Reports

YesYesCloudsense Assessment Reports

YesYesOrchestration

YesYesOpen Automation Modules

YesYesCS Shared Reports

Yes—Remote VM Access

YesYesMobile Access Settings

—YesEnd User Chargeback

YesYesResource Groups

YesYesTag Library

—YesBig Data Infra

Yes—Big Data Accounts

Yes—Big Data Cluster Management

Yes—Big Data Node Management

Yes—Big Data Performance Test

Yes—Big Data Service Management

Yes—Big Data Role Management

Yes—Big Data UCS SP Template

Yes—Big Data Hadoop Profile Template

Yes—BigData HadoopDeploy Template

Yes—Big Data Cluster Deployment

Yes—Big Data License Upload

Yes—Big Data Configuration Parameters
Template

Yes—Big Data Faults

Yes—Big Data Settings - QoS

Yes—Big Data Settings - IP Pool
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PermissionsOperations

WriteRead

Yes—Big Data Settings - Pre_Cluster
Sanity

Yes—Big Data Settings - Hadoop
Software Upload

Yes—Big Data Settings - Configuration
Check Rules

YesYesREST API access

YesYesAllow Change Password - Users

Hadoop User Permissions
A Hadoop user can:

• Read—Permission to only read a file.

• Write—Permission to read, write, and modify a file.

• Read/Write—Permission to read and/or write to a file.

The following table shows a list of operations that a Hadoop user can do:

PermissionsOperations

WriteRead

—YesVirtual Computing

—YesVM Label

—YesAssign VM to VDC

—YesVirtual Storage

—YesVirtual Network

—YesPhysical Computing

—YesPhysical Storage

—YesPhysical Network

YesYesGroup Service Request

YesYesApprover Service Request

—YesBudgeting

—YesResource Accounting
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PermissionsOperations

WriteRead

—YesChargeback

—YesSystem Admin

—YesUsers and Groups

—YesVirtual Accounts

—YesCatalogs

—YesVDC

—YesComputing Policy

—YesStorage Policy

—YesNetwork Policy

—YesService Delivery

—YesResource Limit Report

—YesGroup Users

—YesCloudsense Reports

—YesCloudsense Assessment Reports

——Orchestration

——Open Automation Modules

——CS Shared Reports

——Remote VM Access

——Mobile Access Settings

——End User Chargeback

——Resource Groups

——Tag Library

—YesBig Data Infra

——Big Data Accounts

——Big Data Cluster Management

——Big Data Node Management

——Big Data Performance Test
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PermissionsOperations

WriteRead

——Big Data Service Management

——Big Data Role Management

——Big Data UCS SP Template

——Big Data Hadoop Profile Template

——BigData HadoopDeploy Template

——Big Data Cluster Deployment

——Big Data License Upload

——BigData Configuration Parameters
Template

——Big Data Faults

——Big Data Settings - QoS

——Big Data Settings - IP Pool

——Big Data Settings - Pre_Cluster
Sanity

——Big Data Settings - Hadoop
Software Upload

——Big Data Settings - Configuration
Check Rules

—YesREST API access

——Allow Change Password - Users

Installing Cisco UCS Director Express for Big Data on VMware
vSphere

The Cisco UCS Director, Release 6.5 OVF file includes Cisco UCS Director Express for Big Data, Release
3.5.

We recommend that you use VMware vCenter for OVF deployment. VMware vCenter versions 5.x and above
are supported. OVF deployment wizards support only IPv4 addresses. If you require IPv6, deploy the OVF
with IPv4 addresses and then use the ShellAdmin to configure IPv6 addresses.

Note
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Before you begin

You need administrator privileges to connect to VMware vCenter. Cisco UCSDirector requires a user account
with system administrator privileges to discover, manage and automate VMware vCenter configuration from
Cisco UCSDirector. These operations include creating, deleting and modifying VMs, ESXi hosts and clusters,
datastores and datastore clusters, standard and DV switches, and virtual network port groups.

If you do not want to use DHCP, you need the following information: IPv4 address, subnet mask, and default
gateway.

Note

Step 1 Log in to VMware vSphere Client.
Step 2 In the Navigation pane, choose the Data Center where you want to deploy Cisco UCS Director.

See Cisco UCS Director Installation on VMware vSphere.

Step 3 Choose File > Deploy OVF Template.
Step 4 In the Source pane, do one of the following to choose your OVF source location:

• Click Browse, navigate to the location where you downloaded the OVF, choose the file, and click Open.
• Replace FQDN (Fully Qualified Domain Name) with the path to the URL on your local area network where the
OVF is stored, including the IP address or domain name, and click Next.

Step 5 In the OVF Template Details pane, verify the details, and click Next.
Step 6 In the Name and Location pane, do the following:

a) In the Name field, edit the default VM name.
b) From the Inventory Location area, choose the inventory location where Cisco UCS Director Express for Big Data

is being deployed, and click Next.

If you chose a Data Center in Step 2, option b might not be available.Note

c) Click Next.

Step 7 In the Resource Pool pane, choose the required host, cluster, or resource pool, and click Next.
Step 8 In the Disk Format pane, choose one of the following options and click Next:

• Thick Provisioned (Lazy Zeroed) format—To allocate storage immediately in thick format. This is the
recommended format. All Cisco UCS Director Express for Big Data performance data is verified with this format.

• Thick Provisioned (Eager Zeroed) format—To allocate storage in thick format. It might take longer to create
disks using this option.

• Thin Provisioned format—To allocate storage on demand as data is written to disk.

We recommend that you do not choose the Thin Provisioned format.Important

Step 9 In the Properties pane, enter the following information and click Next:

• Management IP Address—The management IP address to be used for eth0. If your network uses DHCP, leave
the default value of 0.0.0.0.

• Management IP Subnet Mask—The management IP subnet mask to be used for eth0. If your network uses
DHCP, leave the default value of 0.0.0.0.
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• Gateway IP Address

Step 10 In the Ready to Complete pane, do the following:
a) Verify the options that you chose in the previous panes.
b) Check Power on after deployment.

If you do not check this box, you must power on the VM manually after deployment.

c) Click Finish.

Step 11 After the appliance has booted up, copy and paste the Cisco UCSDirector Express for Big Data management IP address
(from the IP address that is shown) into a supported web browser to access the Login page.

Step 12 On the Login page, enter admin as the username and admin for the login password.

We recommend that you change the default admin password after this initial login.Note

Step 13 Choose Administration > License.
Step 14 On the License page, click License Keys.
Step 15 Click Manage Personalities.
Step 16 On the Personality Configuration screen, check the required personalities.

You can check either UCSD or Big Data or both personalities if required.

Step 17 Click Submit.
Step 18 Log in to the CiscoUCSDirector VMconsole with the default shelladmin credentials (for example, shelladmin/changeme)

to apply the selected personalities.
a) Follow the prompts to change the default password.
b) From the Cisco UCS Director Shell Menu, choose Stop Services and press Enter.
c) Press Enter to return to the main menu.
d) From the Cisco UCS Director Shell Menu, choose Start Services and press Enter.
e) Press Enter to return to the main menu.
f) To verify that all services have started, choose Display services status.
g) Choose Quit.

Installing Cisco UCS Director Express for Big Data Bare Metal
Agent on VMware vSphere

Before you begin

• You must have system administrator privileges for VMware vSphere or vCenter.

• If you want to use a static IP address rather than DHCP, you must know the following information:

• IP address

• Subnet mask

• Default gateway
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Step 1 On the Cisco.com download site for Cisco UCS Director, download Cisco UCS Director Bare Metal Agent and unzip
the OVF file.

Step 2 Log in to VMware vSphere Client.
Step 3 In the Navigation pane, click the vSphere host on which you want to deploy Cisco UCS Director Express for Big Data

Bare Metal Agent.
Step 4 Choose File > Deploy OVF Template.
Step 5 On the Source screen of the Deploy OVF Template window, do one of the following to choose your OVF source

location and then click Next:

• If the OVF file is stored on your local computer, browse to the location, choose the file, and click Open.
• If the OVF file is stored on a server on your local area network, enter the location of the file including the IP
address or fully qualified domain name of the server.

Step 6 On the OVF Template Details screen, verify the details and click Next.
Step 7 On the End User License Agreement screen, review the license agreement and click Accept.
Step 8 On the Name and Location screen, do the following:

a) In the Name field, enter a unique name for the VM.
b) In the Inventory Location area, choose the location where you want the VM to reside.
c) Click Next.

Step 9 On the Storage screen, choose the storage location for the VM and click Next.
Step 10 On the Disk Format screen, click Next to accept the default radio button for Thick Provision (Lazy Zeroed) format.
Step 11 On the Network Mapping screen, choose the network for the VM and click Next.
Step 12 On the Properties screen, do the following:

a) Configure the IP addresses for both the NICs (eth0 and eth1) that you want to assign, as follows:

• To use DHCP to assign the IP addresses, leave the default of 0.0.0.0 in the IP address fields.

• To use static IP addresses, enter the desired IP addresses in the IP address fields. If you only want to configure
one NIC, only complete one set of IP addresses and leave the second set at the default.

b) Check the Enable BMA Migration check box to enable the BMA migration process.

By default,Enable BMA Migration check box is enabled. For newOVF deployment, you can uncheck theEnable
BMA Migration check box to disable the BMA migration process.

You can also log on to the Bare Metal Agent VM using SSH client as 'shelladmin' user and choose the
BMA Migration option and press Enter.

Note

c) Specify the existing BareMetal Agent (6.7.4.x) IP address, if you have checked the Enable BMA Migration check
box. Otherwise, enter the IP address as 0.0.0.0.

d) In the Existing BareMetal Agent (6.7.4.x) Root Password section, enter the password in the Enter password
and Confirm password fields.

e) Click Next.

Step 13 On the Ready to Complete screen, verify the settings and click Finish.

A message appears to indicate that Cisco UCS Director Express for Big Data Bare Metal Agent is being deployed.
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Step 14 Log in to the Cisco UCS Director Express for Big Data Bare Metal Agent server with root privileges, and check if you
are able to ping the Cisco UCS Director Express for Big Data Bare Metal Agent server.

Step 15 In the Navigation pane, right-click the Cisco UCS Director Express for Big Data Bare Metal Agent server and choose
Edit Settings.
a) Choose the Resources tab.
b) In the Resource Allocation window, set CPU and Memory Reservation settings to the maximum.
c) Click OK.

Step 16 Power on the VM.

Make sure that Cisco UCS Director is successfully migrated to version 6.8.0.0.Note

During the migration process, dhcpd.conf file of Bare Metal Agent (6.7.4.X) appliance is copied into the
new BareMetal Agent (6.8.0.0) appliance in the /etc/dhcp path. You can check the migration status using
the Migration Status option. For more information, see Viewing the Bare Metal Agent Migration Status,
on page 35. When the migration status is displayed as completed, you can login to the Bare Metal Agent
(6.8.0.0) appliance and navigate to the path /etc/dhcp and perform the following:

• Execute cp legacy_bma_dhcpd.conf_bak /etc/dhcpd.conf.

• Restart the DHCPD services using service dhcpd restart command.

Important

Downloading Cisco UCS Storage and Network Drivers
From Cisco UCS Director, Release 6.6.1.0, we are not packaging the Cisco UCS storage and network drivers
along with Cisco UCS Director Express for Big Data. We recommend you to download the relevant drivers
using the UCS Hardware and Software Compatibility tool.

Step 1 Go to UCS Hardware and Software Compatibility tool.

https://ucshcltool.cloudapps.cisco.com/public/

Step 2 Click Search.
Step 3 Click the required radio button. For example, click the Server radio button to identify the compatible software for the

Cisco UCS server.
Step 4 On the Search Options section, choose the required Server Type, Server Model, Processor Version, Operating

System, and Operating System Version from the drop-down menus.
Step 5 On the Search Results section, refine the search results by checking or unchecking checkboxes next to Product

Category (Adapters) and UCS Server Firmware version number
Step 6 Click Driver ISO under Details section.

By clicking the View Notes and Install & Upgrade Guides links under Documents, you can view the note
details and install and upgrade details.

Note

Step 7 Download a compatible Driver ISO file from the Software Download window.
Step 8 Extract the Storage ISO files.
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To extract the ISO files, navigate to Storage > Intel > C600 > RHEL or Storage > LSI >
C600 > RHEL and choose the required OS. For example,

• For M.2 flash/devices—Storage > Intel > C600 > RHEL > RHEL7.5 >
megasr-18.0*.iso

• For SAS HDD—Storage > LSI > UCSC-RAID-M5 > RHEL > RHEL7.5 >
megaraid_sas-07.0*.iso. You need to extract the iso.gz file, locate the .iso file, and rename the
.iso file name with iso.gz file name.

Note

Step 9 Extract the Network ISO file.

To extract the ISO files, navigate to Network > Cisco > VIC > RHEL and choose the required OS
and copy the .rpm file. For example, Network > Cisco > VIC > RHEL > RHEL7.5

Note

Step 10 Login to Bare Metal Agent through VM Console or SSH client to access the CLI.
Step 11 Create directories for the operating system in the /opt/cnsaroot/bd-sw-rep directory of the BareMetal Agent

VM.

mkdir /opt/cnsaroot/bd-sw-rep/RHEL7.4_MEGARAID_SAS_DRIVERS

mkdir /opt/cnsaroot/bd-sw-rep/RHEL7.4_KMOD_ENIC_DRIVERS

mkdir /opt/cnsaroot/bd-sw-rep/RHEL7.4_MEGASR_DRIVERs

We recommend that you make the directory name descriptive enough that you can identify the operating
system of the images within it. For example, we recommend that you name the directory
RHEL7.5_MEGASR_DRIVERS.

Note

The RHEL7.5_MEGARAID_SAS_DRIVERS, RHEL7.5_KMOD_ENIC_DRIVERS, and
RHEL7.5_MEGASR_DRIVERS directories are used to store the operating system image files.

Step 12 Execute ln -s <<path of the original iso file>> <<target link name>> to provide links to the ISO images.

For example,

ln -s /opt/cnsaroot/bd-sw-rep/RHEL7.4_MEGARAID_SAS/megaraid_sas-07.703.06.00_el7.4-1.x86_64.iso
megaraid_sas_drivers_softlink_to_original.iso

ln -s /opt/cnsaroot/bd-sw-rep/RHEL7.4_MEGASR_DRIVERS/megasr-18.01.2017.1219-1-rhel74-x86_64.iso
megasr_drivers_softlink_to_original.iso

ln -s /opt/cnsaroot/bd-sw-rep/RHEL7.4_KMOD_ENIC_DRIVERS/kmod-enic-2.3.0.44-rhel7u4.el7.x86_64.rpm
kmod_enic_drivers_softlink_to_original.rpm

The links to the RHEL7.5_KMOD_ENIC_DRIVERS should refer to the rpm file, and the MEGASR and
MEGARAID should refer to the iso files.

Note

We recommend that you make the directory name based on the operating system used for the cluster
deployment. For example, CentOS7.5_MEGASR_DRIVERS, CentOS7.5_MEGARAID_SAS, and
CentOS7.5_KMOD_ENIC_DRIVERS directories are used to store the operating system driver image file.
You use the same set of RHEL drivers for CentOS as well.

Note
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NTP Server Configuration on Cisco UCS Director Express for
Big Data Bare Metal Agent

You can configure Cisco UCS Director Express for Big Data BareMetal Agent to have its clock synchronized
to an external NTP server. This ensures that the correct calendar time is maintained on the Bare Metal Agent.

Ensure that you synchronize Cisco UCS Director Express for Big Data and Cisco UCS Director Express for
Big Data BareMetal Agent before you deploy any Hadoop cluster. It is recommended that you also synchronize
Cisco UCS Manager and Cisco UCS Director Express for Big Data on the configured NTP server.

Follow the steps to locate the ntp_server_config.sh:

• Locate /opt/cnsaroot/bigdata_templates/ntp_server_config.sh

• Add execute permissions (chmod+x ntp_server_config.sh)

• Execute ( ./ntp_server_config.sh <ntp_server_ip or hostname>) on the

Cisco UCS Director Express for Big Data Bare Metal Agent

server.

Adding Oracle JDK Software Versions to Bare Metal Agent
You can upload Oracle JDK software and use Oracle JDK for all Hadoop distributions (Cloudera, MapR, and
Hortonworks) through an instant Hadoop cluster and customized Hadoop cluster creation actions. You can
also add new nodes to the existing cluster and support upgrading existing clusters.

Step 1 Log in to the Cisco UCS Director Bare Metal Agent server.
Step 2 Navigate to Solutions > Big Data > Settings and click the Software Catalogs tab to create JDK software version folder

names for each version.
Step 3 Copy JDK files in .rpm or .gz format to the respective version folders.
Step 4 On the menu bar, choose Administration > Integration to track software uploads.
Step 5 Click the Change Record tab to track the software upload in progress and verify if completed, failed, or timeout.

Cisco Server Support for Big Data Cluster Deployments
The table shows Cisco UCS Director Express for Big Data compatibility with Cisco UCS hardware and
software. This table does not reflect the compatibility between Cisco UCS hardware and software.

For information regarding Cisco UCS compatibility, see the Cisco UCSHardware and Software interoperability
Matrices for the appropriate releases.
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All Cisco UCS Director Express for Big Data functionality may not be available across all supported Cisco
UCS software versions. Certain features may not be available in older versions of Cisco UCS software.

Note

Supported VersionsCertified VersionsSoftware Components

Cisco UCS Infrastructure Bundle
and Cisco UCS Manager Software
Bundle, Releases:

• 4.1(x)

• 4.0(x)

• 3.2(x)

• 3.1(x)

• 3.0(x)

• 2.2(x)

Cisco UCS Infrastructure Bundle
and Cisco UCS Manager Software
Bundle, Releases:

• 4.1(1a)

• 4.0(4c) (Cisco UCS Director
Express for Big Data is
supported with fourth
generation fabric interconnect
i.e. Cisco UCS 6454.)

• 3.2(3a)

Cisco UCS Manager

Cisco UCS Infrastructure Bundle
and Cisco UCS Manager Software
Bundle, Release 3.1(2b), Release
3.1(2f), and Release 3.2(2d) forM3
Rack servers

Cisco UCS Infrastructure Bundle
and Cisco UCS Manager Software
Bundle, Release 3.1(2b), Release
3.1(2f), and Release 3.2(2d) forM4
Rack servers and Storage servers

Cisco UCS Infrastructure Bundle
and Cisco UCS Manager Software
Bundle, Release 3.2(2d) for M5
Rack servers

Cisco UCS Infrastructure Bundle
and Cisco UCS Manager Software
Bundle, Release 3.2(2d)

Cisco UCS C-Series Rack-Mount
Servers (Managed by Cisco UCS
Manager)

Cisco Server Support for Splunk Enterprise Deployments
The table shows Cisco UCS Director Express for Big Data compatibility with Cisco UCS hardware and
software. This table does not reflect the compatibility between Cisco UCS hardware and software.

For information regarding Cisco UCS compatibility, see the Cisco UCSHardware and Software interoperability
Matrices for the appropriate releases.

All Cisco UCS Director Express for Big Data functionality may not be available across all supported Cisco
UCS software versions. Certain features may not be available in older versions of Cisco UCS software.

Note
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Supported VersionsCertified VersionsSoftware Components

Cisco UCS Manager

Cisco UCS C-Series Rack-Mount
Servers (Managed by Cisco UCS
Manager)

Adding a New Red Hat Version for Hadoop Cluster
For more information on uploading supported Red Hat Enterprise Linux versions, see Chapter 12, Managing
Hadoop and Splunk Clusters in Cisco UCS Director Express for Big Data Management Guide.

Step 1 On the menu bar, choose Solutions > Big Data > Settings.
Step 2 Click the Software Catalogs tab.
Step 3 Click Add.
Step 4 Click Upload.
Step 5 Choose the target Cisco UCS Director Express for Big Data Bare Metal Agent from the Target BMA drop-down list.
Step 6 Check the Restart BMA Services check box to restart Cisco UCS Director Express for Big Data Bare Metal Agent after

uploading the required files.
Step 7 To verify that the new Red Hat version (operating system software) is available in the Cisco UCS Director Express for

Big Data server, perform the following:
a) Log in to the Cisco UCS Director Express for Big Data user interface.
b) On the menu bar, choose Administration > Physical Accounts.
c) Click the Bare Metal Agents tab.

You can find the new Red Hat version listed in the Image Catalogs column of the Bare Metal Agents report.

New RHEL Version

Red Hat Enterprise Linux 7.2

Download the following file:

• rhel-server-7.2-x86_64-dvd.iso from Red Hat Enterprise Linux

Supported Hadoop Distributions
Cisco UCS Director Express for Big Data supports the following Hadoop distributions:

Supported Hadoop Distribution VersionHadoop Distribution

5.14.0, 5.15.0, 6.0.0, and 6.1.01Cloudera
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Supported Hadoop Distribution VersionHadoop Distribution

5.2.2, 6.0.0, and 6.1.0MapR

2.6.4 and 3.0.0Hortonworks

1 Supported with Cisco BigData Express Connector Pack release 3.7.1.1

For more information on the supported JDK versions and upgrade scenarios, see Cloudera, MapR, and
Hortonworks sites.

Note

Upgrade is not supported for the following:

• Cloudera 5.14.0 to Cloudera 6.0

• Cloudera 5.15.0 to Cloudera 6.0

• Hortonworks 2.6.4 to Hortonworks 3.0.0

• MapR 5.2.2 to MapR 6.1.0

• MapR 6.0.0 to MapR 6.1.0

Important

Supported Splunk Distribution
Cisco UCS Director Express for Big Data supports the following Splunk distribution:

Supported Splunk Distribution VersionSplunk Distribution

7.0.0, 7.1.3, and 7.2.0Splunk

For more information on the upgrade scenarios, see Splunk Enterprise site.Note

Upgarde is not supported for the following:

• Splunk 7.0.0 to Splunk 7.2.0

• Splunk 7.1.3 to Splunk 7.2.0

Important
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Supported Oracle JDK Software Versions
This section lists the supported Oracle JDK software versions:

Supported Upgrade Scenarios for Cloudera
Supported Upgrade VersionHadoop Distribution Version to Upgrade

Cloudera Enterprise 5.5.0, JDK 1.8Cloudera Enterprise 5.4.x, JDK 1.8

Cloudera Enterprise 5.6.x, JDK 1.8Cloudera Enterprise 5.4.x, JDK 1.8

Cloudera Enterprise 5.8.x, JDK 1.8Cloudera Enterprise 5.4.x, JDK 1.8

Cloudera Enterprise 5.8.x, JDK 1.8Cloudera Enterprise 5.6.x, JDK 1.8

Cloudera Enterprise 5.10.0, JDK 1.8Cloudera Enterprise 5.8.0, JDK 1.8

Cloudera Enterprise 5.11.1, JDK 1.8Cloudera Enterprise 5.8.0, JDK 1.8

Cloudera Enterprise 5.13.1, JDK 1.8Cloudera Enterprise 5.8.2, JDK 1.8

Cloudera Enterprise 5.13.1, JDK 1.8Cloudera Enterprise 5.11.1, JDK 1.8

For more information on the supported JDK versions, see Cloudera site.Note

Supported Upgrade Scenarios for MapR
Supported Upgrade VersionHadoop Distribution Version to Upgrade

MapR 6.0.0, JDK 1.8MapR 5.2.1, JDK 1.8

MapR 5.1.0, JDK 1.8MapR 5.0.0, JDK 1.8

MapR 5.2.0, JDK 1.8MapR 4.0.2, JDK 1.8

For more information on the supported JDK versions, see MapR site.Note

Supported Upgrade Scenarios for Hortonworks
Supported Upgrade VersionHadoop Distribution Version to Upgrade

Hortonworks 2.3, JDK 1.8Hortonworks 2.2, JDK 1.7
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Supported Upgrade VersionHadoop Distribution Version to Upgrade

Hortonworks 2.4, JDK 1.8Hortonworks 2.2, JDK 1.7

For more information on the supported JDK versions, see Hortonworks site.Note

Upgrade Hadoop Distribution Software
You can upgrade to the latest Hadoop distributions from the following Hadoop distributions:

Table 2: Cloudera

Supported Upgrade VersionHadoop Distribution Version to
Upgrade

Cloudera-5.4.1Cloudera-5.0.1

Cloudera-5.4.1Cloudera-5.0.6

Cloudera-5.4.1Cloudera-5.2.0

Cloudera-5.4.1Cloudera-5.2.1

Cloudera-5.4.1Cloudera-5.3.0

Cloudera-5.6.xCloudera-5.4.x

Cloudera-5.10.0Cloudera-5.8.0

Cloudera-5.11.1Cloudera-5.8.0

Cloudera-5.13.1Cloudera-5.8.2

Cloudera-5.14.0Cloudera-5.8.2

Cloudera-5.13.1Cloudera-5.11.1

Cloudera-5.14.0Cloudera-5.11.1

Table 3: MapR

Supported Upgrade VersionHadoop Distribution Version to
Upgrade

MapR-4.1.0MapR-4.0.2

MapR-5.0.0MapR-4.0.2

MapR-5.0.0MapR-4.1.0
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Supported Upgrade VersionHadoop Distribution Version to
Upgrade

MapR-6.0.0MapR-5.2.0

Table 4: Hortonworks

Supported Upgrade VersionHadoop Distribution Version to
Upgrade

Hortonworks-2.3

Download ambari-2.1.1-centos6.tar.gz from
http://public-repo-1.hortonworks.com/ambari/centos6/2.x/updates/2.1.1.

Note

Hortonworks-2.2
(ambari-1.7.0-centos6.tar.gz)

Digitally Signed Images
Cisco UCS Director Express for Big Data images are delivered in digitally signed zip files. These signed zip
files are wrapped in a container zip file that includes the following:

• Digitally signed zip file—Contains the Cisco UCS Director Express for Big Data installation image

• Verification program—Verifies the certificate chain and signature. During certificate chain validation,
the program verifies the authenticity of the end-entity certificate using Cisco's SubCA and root CA
certificates. Then, the authenticated end-entity certificate is used to verify the signature.

• Digital signature file—Contains the signature that you can verify before installation.

• Certificate file—Enables you to verify the digital signature. This Cisco-signed x.509 end-entity certificate
contains a public key that can be used to verify the signature. This certificate is chained to the Cisco root
posted on http://www.cisco.com/security/pki/certs/crcam2.cer.

• ReadMe file—Provides the information and instructions required to verify the digitally signed zip file.

Verify the image offline. Once the image is verified, you can begin the installation of Cisco UCS Director
Express for Big Data.

Requirements for Verifying Digitally Signed Images
Before you verify a Cisco UCS Director Express for Big Data digitally signed image, ensure that you have
the following on your local machine:

• Connectivity to https://www.cisco.com during the verification process

• Python 3.4.0 or later

• OpenSSL
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Verifying a Digitally Signed Image

Before you begin

Download the Cisco UCS Director Express for Big Data image from Cisco.com.

Step 1 Unzip the file you downloaded from Cisco.com and verify that it contains the following files:

• ReadMe file

• Digitally signed zip file, for example CUCSD_6_8_0_0_68060_VMWARE_GA.zip or
CUCSD_6_8_0_0_68060_HYPERV_GA.zip

• Certificate file, for example UCS_GENERIC_IMAGE_SIGNING-CCO_RELEASE.cer

• Digital signature generated for the image, for exampleCUCSD_6_8_0_0_68060_VMWARE_GA.zip.signature
or CUCSD_6_8_0_0_68060_HYPERV_GA.zip.signature

• Signature verification program, for example cisco_x509_verify_release.py3

Step 2 Review the instructions in the ReadMe file.

If there are any differences between these instructions and those in the ReadMe, follow the ones in the ReadMe.Note

Step 3 Run the signature verification program from the directory where you have unzipped the downloaded content.

Example: Signature Verification for VMware OVA Installation
python cisco_x509_verify_release.py3 -e UCS_GENERIC_IMAGE_SIGNING-CCO_RELEASE.cer
-i CUCSD_6_8_0_0_68060_VMWARE_GA.zip -s CUCSD_6_8_0_0_68060_VMWARE_GA.zip.signature -v dgst
-sha512

Example: Signature Verification for Hyper-V VHD Installation
python cisco_x509_verify_release.py3 -e UCS_GENERIC_IMAGE_SIGNING-CCO_RELEASE.cer
-i CUCSD_6_8_0_0_68060_HYPERV_GA.zip -s CUCSD_6_8_0_0_68060_HYPERV_GA.zip.signature -v dgst -sha512

Step 4 Review the output and ensure that the verification has succeeded.

Example: Expected Output for VMware OVA Installation
Retrieving CA certificate from http://www.cisco.com/security/pki/certs/crcam2.cer ...
Successfully retrieved and verified crcam2.cer.
Retrieving SubCA certificate from http://www.cisco.com/security/pki/certs/innerspace.cer ...
Successfully retrieved and verified innerspace.cer.
Successfully verified root, subca and end-entity certificate chain.
Successfully fetched a public key from UCS_GENERIC_IMAGE_SIGNING-CCO_RELEASE.cer.
Successfully verified the signature of CUCSD_6_8_0_0_68060_VMWARE_GA.zip using
UCS_GENERIC_IMAGE_SIGNING-CCO_RELEASE.cer

Example: Expected Output for Hyper-V VHD Installation
Retrieving CA certificate from http://www.cisco.com/security/pki/certs/crcam2.cer ...
Successfully retrieved and verified crcam2.cer.
Retrieving SubCA certificate from http://www.cisco.com/security/pki/certs/innerspace.cer ...
Successfully retrieved and verified innerspace.cer.
Successfully verified root, subca and end-entity certificate chain.
Successfully fetched a public key from UCS_GENERIC_IMAGE_SIGNING-CCO_RELEASE.cer.
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Successfully verified the signature of CUCSD_6_8_0_0_68060_HYPERV_GA.zip using
UCS_GENERIC_IMAGE_SIGNING-CCO_RELEASE.cer

What to do next

Install or upgrade Cisco UCS Director Express for Big Data.

Upgrade of Bare Metal Agent
For detailed information on upgrading Bare Metal Agent, see the Cisco UCS Director Upgrade Guide.

Updating Bare Metal Agent
A new system task (Update BMA Appliance Task) is created within the account. Navigate to the Big Data
Tasks folder here: Administration > System > System Tasks. The system scheduler connects to all Bare
Metal Agents that are currently managed, performs a version check, stops services, pushes the required updates,
and starts the services. This task is performed when

• the Cisco Big Data Express connector pack is upgraded.

• a BMA is added.

If any of the BMA goes down and update fails, you should add the BMA to kickstart the process again. You
can use the system task history to check for any failures and add the BMA again to trigger the process.

Note

Monitoring Big Data Statistics for MapR Account
A new system task (monitor) is created within the MapR account. Navigate to the Big Data Tasks folder here:
Administration > System > System Tasks. The system task connects to the MapR account and generates
the relevant statistical data based on your requirement.

Configuring Cisco UCS Manager Accounts
Each Cisco UCS Manager account represents a single Cisco UCS domain that has to be managed by Cisco
UCS Director Express for Big Data. See Cisco UCS Director Management Guide for Cisco UCS Manager.

High-level Workflow to Create an Instant Hadoop Cluster

Step 1 Create a Cisco UCS Manager account. See Cisco UCS Director Management Guide for Cisco UCS Manager.
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Step 2 Configure Big Data IP pools. See Adding a Big Data IP Pool.
Step 3 Create an Instant Hadoop Cluster. See Creating an Instant Hadoop Cluster.

High-level Workflow to Create a Customized Hadoop Cluster

Step 1 Configure a Cisco UCS Service Profile template for Big Data. For more information, see Creating a Cisco UCS Service
Profile Template for Big Data.

Step 2 Create a Hadoop cluster configuration parameters template. See Create a Hadoop Cluster Configuration Parameters
Template.

Step 3 Configure a Hadoop cluster profile template. See Creating a Hadoop Cluster Template.
Step 4 Configure a Hadoop cluster deployment template. See Creating a Hadoop Cluster Deploy Template.
Step 5 Create a customized Hadoop cluster. See Creating a Customized Hadoop Cluster.

Device Connector
The device connector connects Cisco UCSDirector Express for Big Data to Cisco Intersight, the cloud-hosted
server management system. It enables Cisco UCSDirector Express for Big Data to bemanaged andmonitored
through Cisco Intersight.

To register a device with Cisco Intersight in the cloud, you must do the following:

1. Configure the device connector proxy settings to connect with Cisco Intersight.

This is required only if you have proxy configuration enabled.

2. Validate your access to the device from Cisco Intersight using the device serial number and the security
code and claim the device.

After a system running Cisco UCS Director Express for Big Data is claimed in Cisco Intersight, you must
refresh the information displayed on the Device Connector screen. Choose Administration > Device
Connector to view the updated information.

Note

Configuring Device Connector

Step 1 Choose Administration > Device Connector.
Step 2 Click Settings.
Step 3 In the Settings dialog box, choose Proxy Configuration.
Step 4 For the HTTPS Proxy field, move the slider to Enabled.
Step 5 Enter the proxy hostname or IP address in the Proxy Hostname/IP field.
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Step 6 Enter the proxy port number in the Proxy Port field.
Step 7 To authenticate access to the proxy server, turn the Authentication mode on and enter the Username and Password.
Step 8 Click Ok.

Based on the connectivity to Cisco Intersight, the Status field displays one of the following messages:

• When the connection to Cisco Intersight is successful, the status messages could be one of the following:

• Unclaimed—Implies that the connection is successful but the device is not claimed. You can claim an unclaimed
connection through Cisco Intersight.

For information on claming a device, see the integrated guided walkthrough titled Learn How to Claim a Device
available within the Online Help menu in the Cisco Intersight user interface.

• Claimed—Implies that the connection to Cisco Intersight is successful and you have claimed the device.

The header pane of the user interface now includes an icon to indicate the status of the device in Cisco
Intersight. This icon is visible only to administrator users and the status change is reflected only when the
browser is refreshed or when a new login session is initiated.

DescriptionIcon

Indicates that the device is not claimed in Cisco
Intersight.

Indicates that the device is claimed in Cisco
Intersight.

Note

• When the connection to Cisco Intersight is unsuccessful, the status messages could be one of the following:

• Administratively disabled—Implies that the administrator has disabled managing the device from Cisco
Intersight.

• Certification Validation Error—Implies that an invalid certificate exists on the system.

• Not Claimed—Indicates that the device is registered, but not claimed in Cisco Intersight.

• DNS is not configured or DNS is mis-configured.

• Unable to resolve DNS name of the service—Indicates that although DNS is configured, the DNS name of
the Cisco Intersight platform cannot be resolved.

• NTP is not configured

• Unable to establish a network connection—Indicates that Cisco UCS Director cannot connect to Cisco
Intersight.

If you have enabled HTTP using option 28 from the Shell Admin console, then the status messages displayed on this
screen may not be accurate.
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Viewing Device Connector Properties

Step 1 Choose Administration > Device Connector.
Step 2 In the subsequent screen, review the following information:

DescriptionName

Intersight Management Area

Displays if you have enabled connections to the Cisco
Intersight management platform. It can be one of the
following:

• Enabled

• Disabled

Current Status Indicator

Displays the current access mode to connect to the Cisco
Intersight management platform. It can be one of the
following:

• Read-only—Permission to only view the reports.

• Allow Control—Permission to perform all the
operations as an administrator.

Access Mode

Connection Area

Whether HTTPS proxy settings are disabled or manually
configured. This can be one of the following:

• Off—Select this option if you want to disable the
HTTPS proxy settings configuration.

This is the default HTTPS proxy setting.

• Manual—Select this option if you want to enable the
HTTPS proxy settings configuration.

• Proxy Hostname/IP—Enter the proxy hostname
or IP address.

• Proxy Port— Enter the proxy port number.

• Authentication—Enable this option to
authenticate access to the proxy server.

Enter the Username and Password to authenticate
access.

HTTPS Proxy Settings button
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DescriptionName

The current status of the connection to the Cisco Intersight
management platform. It can be one of the following:

• Administratively disabled—Implies that the
administrator has disabled managing the device from
Cisco Intersight.

• Certification Validation Error—Implies that an
invalid certificate exists on the system.

• Claimed—Indicates that the device is claimed in Cisco
Intersight.

• Not Claimed—Indicates that the device is registered,
but not claimed in Cisco Intersight.

• DNS is not configured or DNS is mis-configured.

• Unable to resolve DNS name of the
service—Indicates that although DNS is configured,
the DNS name of the Cisco Intersight platform cannot
be resolved.

• NTP is not configured

• Unable to establish a network connection—Indicates
that Cisco UCS Director cannot connect to Cisco
Intersight.

To learn why the connection failed, click the Details &
Recommendations drop-down list and then click Retry
Connection.

Status

The unique identification number of the device.Device ID

Launching Cisco UCS Director Express for Big Data from Cisco
Intersight

After the device connector is configured and the device is claimed, you can launch the Cisco UCS Director
Express for Big Data user interface from Cisco Intersight.

If any of the Cisco UCS Director Express for Big Data services are down, you cannot launch Cisco UCS
Director Express for Big Data from Cisco Intersight.

A message stating that there is no service is displayed.

Important

Overview
26

Overview
Launching Cisco UCS Director Express for Big Data from Cisco Intersight



Although you can launch Cisco UCSDirector Express for Big Data from Cisco Intersight, following are some
of the restrictions that you need to be aware of:

• You cannot edit a user profile.

• You cannot perform any import and export actions.

• The main menu and the Dashboard are disabled.

• The Device Connector tab is not visible.

• You cannot perform any launch actions.

• You cannot upgrade connector packs.

• You cannot generate any summary reports.

• The user name is displayed as Cisco Intersight user when you launch Cisco UCS Director Express for
Big Data.

• All service requests and audit log details are logged as Admin user.

Step 1 Log into the Cisco Intersight user interface.
Step 2 Choose Devices.

The Devices screen appears that displays a list of available Cisco UCS Director Express for Big Data systems.
Step 3 Select a Cisco UCS Director Express for Big Data device from the list, and click .....

You must scroll to the far right of the list of devices to see the .... option.

The IP address displayed for the Cisco UCS Director Express for Big Data device in Cisco Intersight is
determined by the IP address you entered for the Server IP address field while configuring the outgoing mail
server for Cisco UCS Director Express for Big Data.

If you modify the server IP address after the Device Connector process is up, you must restart the Device
Connector process. To do so, login to the Cisco UCSDirector Express for Big Data device, and run the following
commands:
/opt/infra/bin/stopdc.sh
/opt/infra/bin/startdc.sh

Refresh the Devices screen in Cisco Intersight to view the updated server IP address.

Note

Step 4 Choose Launch UCSD.

Cisco Intersight is connected to the Cisco UCSDirector Express for Big Data system and the Cisco UCSDirector Express
for Big Data user interface opens in a new tab.

Users with read-only permissions created in Cisco Intersight cannot perform any actions. These users can only
view reports.

Note
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Base Platform Pack and System Update Manager
Cisco UCS Director Express for Big Data includes the capability to update the following components of the
software:

• Base Platform Pack—Includes basic infrastructure components such as the user interface, Shell admin
console changes, and critical defect fixes.

• System Update Manager—Includes the framework that helps you upgrade all connector packs and the
base platform pack.

• Connector Packs—Includes connector-specific updates and critical defect fixes, which you can upgrade
in your environment without affecting other connectors. See Connector Pack Management, on page 30.

Prior to upgrading any of these packs, ensure that the following prerequisites are met:

• You must have system administrator privileges in Cisco UCS Director Express for Big Data.

• Cisco UCS Director Express for Big Data has been claimed in Cisco Intersight.

• Cisco UCS Director Express for Big Data is successfully connected to Cisco Intersight.

• The latest version of the Base Platform connector pack is installed.

When you login to the user interface, the header pane will indicate the number of updates that are available
for your system. Clicking that number will display the Available System Upgrades screen. This screen
displays information on base packs and the connector packs that are available for upgrade. From this screen,
you can perform the following actions:

• Upgrade connector packs that you need for your environment.

See Upgrading Connector Packs, on page 31.

• Upgrade the Base Platform pack—Selecting this base pack will also automatically select the System
Update Manager Pack, and the connector packs that are available for upgrade.

• Upgrade only the System Update Manager

See Upgrading the System Update Manager, on page 29.

• Upgrade the connector packs, Base Platform pack and System Update Manager together

If you select all three options, the System Update Manager is upgraded first, followed by the connector
packs, and then finally the Base Platform pack. After the System Update Manager upgrade is complete,
the System Update Manager service is restarted, following which the upgrade process for the connector
packs and the Base Platform pack is initiated. If the upgrade process for the connector packs fail, then
the versions on the system are reverted to the previously installed versions, and the upgrade of the Base
Platform pack is also terminated.

Upgrading Base Platform Pack

Before you begin

• You must have system administrator privileges in Cisco UCS Director Express for Big Data.
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• Cisco UCS Director Express for Big Data has been claimed in Cisco Intersight.

• Cisco UCS Director Express for Big Data is successfully connected to Cisco Intersight.

• The latest version of the Base Platform connector pack is installed.

Step 1 On the header, click New Upgrades Available.

The Available System Upgrades screen appears that displays a list of available connector packs for upgrade along with
the version information.

The New Upgrades Available icon is visible on the header only when new versions of the current running
connector packs are available for upgrade.

Note

Step 2 Check the Base Platform check box.

Checking this check box will also automatically select the System Update Manager and connector packs, if available.

Step 3 Click Upgrade.

To complete the upgrade, the required Cisco UCS Director Express for Big Data services will restart.

Step 4 In the Confirm Upgrade dialog box, click Yes to proceed with the upgrade.

After you click Yes, the validation process is initiated. If the validation process completes successfully, the upgrade
process is initiated and the System Upgrade Status screen displays the upgrade status.

For more information on possible outcomes of the validation and upgrade process, see Upgrade Process Validation and
Failure Scenarios, on page 33.

Step 5 Review the status messages on the System Upgrade Status screen.
Step 6 After the upgrade process completes successfully, click Logout.

While upgrading a base platform pack that includes changes to all infrastructure components, all Cisco UCS Director
services are restarted. As a result, after clicking Logout, the screen could appear to be unresponsive for a few minutes.
After all the services are restarted, and the upgrade process is complete, you can login to Cisco UCS Director.

Step 7 Login to the user interface.

Upgrading the System Update Manager

Before you begin

• You must have system administrator privileges in Cisco UCS Director Express for Big Data.

• Cisco UCS Director Express for Big Data has been claimed in Cisco Intersight.

• Cisco UCS Director Express for Big Data is successfully connected to Cisco Intersight.

• The latest version of the Base Platform connector pack is installed.

Step 1 On the header, click New Upgrades Available.
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The Available System Upgrades screen appears that displays a list of available connector packs for upgrade along with
the version information.

The New Upgrades Available icon is visible on the header only when new versions of the current running
connector packs are available for upgrade.

Note

Step 2 Check the System Update Manager check box.
Step 3 Click Upgrade.

To complete the upgrade, the required Cisco UCS Director Express for Big Data services will restart.

Step 4 In the Confirm Upgrade dialog box, click Yes to proceed with the upgrade.

After you click Yes, the validation process is initiated. If the validation process completes successfully, the upgrade
process is initiated and the System Upgrade Status screen displays the upgrade status.

For more information on possible outcomes of the validation and upgrade process, see Upgrade Process Validation and
Failure Scenarios, on page 33.

Step 5 Review the status messages on the System Upgrade Status screen.
Step 6 After the System Update Manager upgrade process completes successfully, click Logout.

After the upgrade process is complete, the System Update Manager service is restarted.

Step 7 Login to the user interface.

Connector Pack Management
Connector packs help you perform connector level upgrade in Cisco UCS Director Express for Big Data
without impacting other connectors. After a system running Cisco UCS Director Express for Big Data is
claimed in Cisco Intersight, as a system administrator, you can view information on new versions of connector
packs that are available for upgrade. The top header pane of the user interface displays a notification indicating
that new connector pack versions are available. You can select and upgrade the connector packs on the system.
For more information, see Upgrading Connector Packs, on page 31.

Connector packs help you perform connector level upgrade in Cisco UCS Director Express for Big Data
without impacting other connectors. As a system administrator, you can view information on new versions
of connector packs that are available for upgrade.

Following are the connectors that are available in this release:

• Cisco UCS which includes Cisco UCS Central and Cisco UCS Manager

• ACI APIC

• ACI Multi-Site Controller

• F5 Load Balancer

• Network Devices

• EMC Isilon

• EMC RecoverPoint
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• EMC VMAX

• EMC VNX

• EMC VNXe

• EMC VPLEX

• EMC Unity

• EMC XtremIO

• IBM

• NetApp ONTAP

• VCE VisionIO

• Microsoft Hyper-V

• RedHat KVM

• Vmware

• Bare Metal Agent

• Cisco IMC

• Cisco BigData Express

• Cisco HyperFlex

As a system administrator, you can upgrade connector packs from:

• Cisco UCSDirector Express for Big Data. For more information on upgrading the connector packs using
Cisco UCS Director Express for Big Data user interface, see Upgrading Connector Packs, on page 31.

• Cisco Intersight user interface in which Cisco UCS Director Express for Big Data is claimed. For more
information on upgrading the connector packs from Cisco Intersight UI, see Upgrading Connector Packs
on UCS Director Instances.

The top header pane of the user interface displays a notification indicating that new connector pack versions
are available.

Latest versions of these connectors are made available to Cisco UCS Director Express for Big Data only
through Cisco Intersight. So Cisco UCS Director Express for Big Data must be claimed in Cisco Intersight.

Important

Upgrading Connector Packs
As a system administrator, you can upgrade connector packs using the Cisco UCS Director Express for Big
Data graphical user interface. When new connector pack versions are available, the system notifies you in the
following ways:

• Pop-up message when you log in to Cisco UCS Director user interface.
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When you log in to the user interface of Cisco UCSDirector, and if there are new connector pack versions
available for upgrade, a pop-up message prompting you to upgrade these versions is displayed. Click
Yes to upgrade these connector pack versions immediately or click No to upgrade at a later time.

This pop-up notificationmessage is displayed once every 3 days. It is not displayed
every time you log in to the user interface.

Note

• An alert with a downward facing arrow image and a number in the header pane of the user interface.

This number indicates the number of connector packs that are available for upgrade.

The pop-up message and the alert on the header pane are displayed only when Cisco UCS Director Express
for Big Data has been claimed in Cisco Intersight. For information on establishing a connection with Cisco
Intersight, see Configuring Device Connector, on page 23.

You can upgrade system packs (System Update Manager, Base Platform Pack and Connector Pack versions)
in a standalone setup and in a multi-node setup. In a multi-node setup, you must upgrade the versions only
on the primary node.

Note

Before you begin

• You must have system administrator privileges in Cisco UCS Director Express for Big Data.

• Cisco UCS Director Express for Big Data has been claimed in Cisco Intersight.

• Cisco UCS Director Express for Big Data is successfully connected to Cisco Intersight.

• The latest version of the Base Platform connector pack is installed.

Step 1 On the header, click New Upgrades Available.

The Available System Upgrades screen appears and will display all available connector packs for upgrade along with
version information. Upon login, if you clicked Yes to the pop-up message, then the very same upgrade screen appears.

The New Upgrades Available icon is visible on the header only when new versions of the current running
connector packs are available for upgrade.

Note

Step 2 Check the check box of a connector pack from the list.

You can check the check boxes of multiple connector packs.

Step 3 Click Upgrade.
Step 4 In the Confirm Upgrade dialog box, click Yes.

After you confirm that the connector version must be upgraded, the validation process is initiated. If the validation process
completes successfully, the upgrade process is initiated and the System Upgrade Status screen displays the upgrade
status. After the upgrade process is successful, the Logout option is enabled.

Step 5 Click Logout.
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While upgrading a base platform pack that includes changes to all infrastructure components, all Cisco UCS Director
services are restarted. As a result, after clicking Logout, the screen could appear to be unresponsive for a few minutes.
After all the services are restarted, and the upgrade process is complete, you can login to Cisco UCS Director Express
for Big Data.

What to do next

You can view the upgrade reports by choosing Administration > System > System Updates. From this
screen, you can double-click on a report, and view additional details on the upgrade process. For more
information, see Viewing Connector Pack Upgrade Information, on page 35.

Upgrade Process Validation and Failure Scenarios
After you initiate a system pack upgrade, a validation process is initiated in the system. The following table
describes the possible outcomes of the validation for system packs:

Recommended ActionInformation in the User
Interface

Validation Process
Outcome

Scenario

None.

The upgrade process is
initiated.

The System Upgrade
Validation screen displays the
status

SucceedsNo problems with any
system pack versions

No workflows in
progress

No users logged into
the system

Review the information and
perform the corrective action
suggested.

The System Upgrade
Validation screen displays an
error message and corrective
action.

FailsProblems with one or
more system packs
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Recommended ActionInformation in the User
Interface

Validation Process
Outcome

Scenario

Review the corrective action,
and click Force Upgrade to
proceed with the upgrade.

The Force
Upgrade option is
available only for
Base Platform pack
and connector
packs. It is not
displayed for the
System Update
Manager.

Note

The System Upgrade Status
screen is displayed with
current status for the upgrade
request.

Users are automatically
logged out of the system with
a system broadcast message
about the upgrade.

The System Upgrade
Validation screen displays an
error message and corrective
action.

FailsOther users are logged
into the system

or

Workflows are in
progress

After validation process completes successfully, the upgrade process is initiated and the System Upgrade
Status screen displays the status. On successful completion of the upgrade process, the Logout option is
enabled on the user interface. The following table describes the possible issues that you could encounter during
an upgrade process:

Impact to Upgrade ProcessInformation in the User InterfaceScenario

The upgrade process completes
successfully.

The System Upgrade Status
screen is displayed to the user with
current status for the upgrade
request.

System pack upgrade is in progress
and other users with administrator
privileges logs in to the user
interface.

The upgrade process completes
successfully.

The system startup page is
displayed to the user.

System pack upgrade is in progress
and an end user logs in to the user
interface.

When the upgrade process for any
system pack fails, then the version
of that system pack is reverted to
the previously installed version.

The System Upgrade Status
screen displays the status of the
upgrade.

The overall upgrade status is
indicated as partially completed.
The status for each system pack
will help you determine the system
pack that was not upgraded.

You selected multiple packs for
upgrade, and the upgrade for one
system pack fails.
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Impact to Upgrade ProcessInformation in the User InterfaceScenario

Although the System Upgrade
Status screen does not display the
complete workflow, the upgrade
process completes successfully.

If the base platform pack that you
selected for upgrade includes an
update to the Tomcat service, then
the System Upgrade Status screen
does not display the complete
workflow of the upgrade process.
This is because the Tomcat service
restarts in the system which results
in terminating your session in the
user interface. Also, you are
automatically directed to the system
start-up screen. You can login to
the user interface only after all
Cisco UCS Director services are
restarted.

You selected the base platform
pack for upgrade and you are
logged out of the user interface
before the System Upgrade Status
screen displays the complete
workflow of the upgrade process.

Viewing Connector Pack Upgrade Information

Step 1 Choose Administration > System.
Step 2 On the System page, click Connector Pack Upgrades.

Information such as upgrade request ID, user that initiated the upgrade, upgrade start time and end time, and the upgrade
status are displayed.

Step 3 Select a connector pack and choose View Details to view details such as connector pack name, upgraded version, and
prior version.

Step 4 Click State History to view the various states of the connector pack upgrade process. For example, upgrade request
received, upgrade process initiated or upgrade process completed.

Step 5 Click Stages to view the entire lifecycle of the connector pack upgrade request.

Viewing the Bare Metal Agent Migration Status

From the Bare Metal Agent Shell menu, choose the Migration Status option and press Enter.

The following information displays:

Migration Status : Completed
Successfully completed the BMA migration.
Press return to continue:
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The BMA migration status can be one of the following:

• Completed

When the migration status is displayed as Completed, log in to Cisco UCS Director, Release
6.8 and chooseAdministration > Physical Accounts and clickBare Metal Agent. On theAdd
Bare Metal Agent Appliance screen, delete the BMA account (specific to version 6.7.4.x) and
add the BMA account (migrated BMA, version 6.8.0.0) to Cisco UCS Director, Release 6.8.

Note

• In Progress

• Failed

• Not Triggered

Note
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